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L E A R N I N G  T H E  B A S I C S
L E A R N I N G  T H E  B A S I C S

PALM® TREO™ 700W SMARTPHONE OVERVIEW

The following illustrations show the locations and names of the physical features of your 
Palm® Treo™ 700w smartphone. Refer to these illustrations while following this guide.

Indicator light (phone 
and charge indicator)

Multi-
connector

5-way navigator

Earpiece

Power/End button

Microphone

Headset 
jack

Start 
button

Phone/Send 
button

Side button

OK button

Volume button

Action keys
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Ringer switch

Antenna

Infrared (IR) port

StylusExpansion card slot

Camera lens 
(camera smart-
phone only)

Battery door release

Speaker

Self-portrait mirror
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L E A R N I N G  T H E  B A S I C S
TURNING YOUR SMARTPHONE ON/OFF

You can use the organizer features of your Treo 700w smartphone independently of the wireless 
features and applications. In other words, the screen and phone are designed to be turned off and 
on separately.

NOTE To conserve battery power, the screen turns off automatically after one minute. If you want the screen to stay on 
longer, you can adjust the shutoff setting. Press Start, select Settings, select the System tab, and then select Power. Select 
the Advanced tab, and then increase the On battery power setting.

Turning your phone on and off
When you turn on your phone, it connects to a mobile network so that you can make and receive 
phone calls and use other wireless services. 

1. Press and hold Power/End  to turn on your phone. When your smartphone locates a 
signal, Verizon Wireless and the signal-strength icon  appear at the top of the screen and 
the indicator light flashes green, indicating you can use the phone and Internet features (if 
supported by the local network). If you’re outside a coverage area, the indicator light flashes 
amber and no bars appear in the signal-strength icon.

2. Press and hold Power/End  again to turn off your phone. When your phone is off, the 
phone-off icon  appears at the top of the screen and your smartphone is not connected to 
any mobile network. You can still use the organizer and other features.

Waking up the screen
To use the organizer features when your smartphone’s screen is off, you need to wake up the 
screen. You can also turn off your smartphone’s screen without turning off your smartphone’s 
wireless features.
3



1. Press Power/End  to wake up the screen.

2. Briefly press Power/End  to turn off the screen.

MOVING AROUND THE SCREEN

To move around the Treo 700w smartphone screen, you can use the 5-way navigator or you can 
tap items on the screen with the stylus. As you become familiar with your smartphone, you’ll find 
your own favorite way to scroll, highlight, and select items.

The 5-way includes Right , Left , Up , Down , and Center buttons.

Scrolling through screens
As on a computer, on your smartphone you scroll to move from field to field or page to page, 
or in some cases to highlight an item or option in a list. 

Up

RightLeft

Down

Center
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L E A R N I N G  T H E  B A S I C S
There are several methods of scrolling:

■ Press the 5-way on the front of your smartphone. Press Right , Left , Up , or Down  
to move to the next field, button, or action in that direction.

■ Press and hold Option  while pressing Up  or Down  to 
scroll one screen at a time. These keys work just like the 
Page Up and Page Down keys on your computer keyboard.

■ Press and hold Option  while pressing Left  or Right  to 
jump to the top or bottom of the current document or entry.

■ When viewing a screen with tabs, such as when adding a 
contact or customizing settings, press Down  to scroll to 
the tabs, and then press Left  or Right  to move between 
tabs.

■ When inside a text field, press Right  or Left  to move to 
the next character, and press Up  or Down  to move 
between lines. 

■ When inside a list, press and hold Up  or Down  to rapidly scroll through the list.

■ Tap an onscreen scroll arrow.

■ Tap and drag the slider of an onscreen scroll bar.

Scroll arrows

Scroll arrows
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Closing screens
To accept the information you entered on a screen and to return to the previous screen, do one of 
the following:

■ Press OK .

■ Use the stylus to tap  or  in the upper-right corner of the screen.

Highlighting and selecting items
On most screens, one item—a button, a list entry, or a check box—is highlighted by default. The 
highlight identifies which item is affected by your next action. Use the 5-way to move the 
highlight from one item to another before opening or selecting it. 

The highlight can take one of two forms, depending on what is highlighted:

■ Border glow: This rectangular border highlights items such as an 
onscreen button (for example OK, Dismiss, or Hide), a check box, 
an option, or a web link. 

■ Reverse type (light text on a dark background): This 
highlights items such as a phone number, an email address, 
text, or an item in a list.

After highlighting an item with the 5-way, you can select or 
activate it by pressing Center or by tapping the item with the stylus.
6



L E A R N I N G  T H E  B A S I C S
Using the action keys
The action keys are designed to give you quick access to relevant tasks, so the action key items 
vary from application to application, and from screen to screen, and in some cases may not be 
available at all. Action keys activate the items that appear directly above them on the screen. In 
most cases the right action key  opens the menu, and the left action key  activates a 
specific command, such as New or Edit. Remember that action key functions vary from screen to 
screen, so be sure to check the onscreen label before pressing the action keys. 

Selecting menu items
In many applications, a menu provides access to additional features. The menu is hidden until 
you press Menu . To get the most out of your smartphone, it’s a good idea to familiarize 
yourself with the additional features available through the menu in various applications.

Left action key Right action key

Left action key activates 
this command

Right action key activates 
this command
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1. Press Menu  to display an application’s menu.

2. Press Up  or Down  to highlight a menu item.

3. If an arrow appears next to a menu item, press Center or Right  
to display additional options for that item, and then press Up  
or Down  to highlight a menu item. To return to the main menu 
without making a selection, press Left .

4. Press Center to select the menu item, or press Left  or 
Menu  to close the menu and cancel your selection.

Selecting options in a shortcut menu
Most applications also provide access to context-sensitive, shortcut 
menus—similar to the right-click menus on a computer. The 
shortcut menu options vary based on the highlighted selection.

1. Highlight the item you want to open the shortcut menu for.

2. Press and hold Center to open the shortcut menu.

3. Press Up  or Down  to highlight a menu item.

4. Press Center to select the menu item or press Left  to cancel 
your selection.
8



L E A R N I N G  T H E  B A S I C S
Selecting options in a list
Lists let you select from a range of options. You can identify whether 
a list is available when you select the field. If a rectangle appears 
around the field along with a downward-pointing arrow, a list is 
available. Lists are different from the menus described earlier in this 
section. 

To select from a list, do any of the following:

■ Use the 5-way to highlight the field, and then press Center to 
display the items in the list. Press Up  or Down  to highlight 
the item you want, and then press Center to accept your 
selection.

■ Use your stylus to tap the arrow, and then tap the item in the list.

■ To exit the list and cancel your selection, press Left .

NOTE When selecting fields you might not see the downward-pointing arrow until you 
press Center. In fields where you see a downward-pointing arrow but no rectangle, you 
must tap the arrow with the stylus to expand the field. 
9



USING THE KEYBOARD

When using the keyboard, most people find it easiest to hold the smartphone with two hands and 
to use the tips of both thumbs to press the keys.

Understanding the keyboard backlight
Your smartphone includes a keyboard backlight for low light conditions. The keyboard backlight 
activates automatically when the screen turns on. It turns off automatically when the screen turns 
off or when you are on a call or playing music in the background for longer than the time 
specified in Backlight Settings. The backlight also turns off when an application’s power-saving 
features turn it off.

Action key Action key
Phone/Send

Start

Power/End

OK

Backspace

Option

Shift

Space

Return

Shift

Alt
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L E A R N I N G  T H E  B A S I C S
Entering lowercase and uppercase letters
By default, the first letter of each sentence or field is capitalized and the remaining text you enter 
is lowercase. To enter other uppercase letters, do one of the following: 

■ Press Shift , and then enter a letter. You don’t need to press and hold Shift while entering 
a letter.

■ Press Shift  twice to turn on Caps Lock, and then enter a series of letters. When Caps Lock 
is on, this symbol appears at the bottom of the screen: . To turn off Caps Lock, press Shift 

 again. 

Entering numbers, punctuation, and symbols 
Numbers, punctuation, and symbols appear above the letters on the keys. To enter these 
characters, do one of the following: 

■ Press Option , and then press the key of the desired character. You don’t need to hold 
Option while pressing the key.

■ Press Option  twice to turn on Option Lock, and then press the desired keys to enter a 
series of characters. When Option Lock is on, this symbol appears at the bottom of the 
screen: . To turn off Option Lock, press Option  again. 
11



Entering other symbols and accented characters
You can enter symbols and accented characters that don't appear on the keys using the alternate 
characters list. The alternate characters are grouped according to their similarity to the 
corresponding key. For example, the alternate characters available for the e key are é, è, ë, and ê. 
If you press the wrong key, press Backspace to return to the full list of alternate characters. You 
can then press another key.

1. Press Alt  to display the alternate character list.

2. Narrow the list by pressing the key that corresponds to the character you want. For example, 
to enter an é, press e. See the table on the next page for a list of corresponding characters.

3. Press Up  or Down  to highlight the desired character.

4. Press Center to insert the character.

NOTE If you don’t know which key to press to narrow the list in step 2, you can scroll through the list until you find the 
character you want.
12



L E A R N I N G  T H E  B A S I C S
Symbols and accented characters 

Press Alt 
 and 

enter... 

to select... Press Alt 
 and 

enter... 

to select... Press Alt 
 and 

enter... 

to select...

a á à ä â ã å æ o ó ò ö ô œ õ 0 °

A Á À Ä Â Ã Å Æ O Ó Ò Ö Ô Œ Õ 1

b or B ß p or P ¶ 2

c ç ¢ © r or R ® 3

C Ç ¢ © s ß Šs §

e é è ë ê S ß ŠS §

E É È Ë Ê t or T ™ $  £ ¥ ¢

i í ì ï î u ú ù ü û ! ¡

I Í Ì Ï Î U Ú Ù Ü Û ? ¿

l or L £ x or X x ¤ ; :-) :-( ;-)

n ñ y   ÿ . , ' " @ + - 
* / # ( or ) 

: & _ • % = ÷ ̂   £ ¥ 
¢ [ ] { } < > « » © ® ° 
~ \ Ø µ |N Ñ Y   Ÿ
13



OPENING AND CLOSING APPLICATIONS

Opening applications
You can access all the applications on your 
smartphone through the Start menu:

1. Press Start  to open the Start menu. 

2. Use the 5-way navigator to highlight the 
application you want to use. To view additional 
applications, select Programs.

3. Press Center to open the selected application.

Closing applications
You can have several applications open at once, so you don’t need to exit an application to open 
another one. In most cases, applications close automatically when available memory is low, but 
you can also close applications manually.

1. Press and hold OK  to open the Memory Settings screen.

2. On the Running Programs tab, do one of the following:

■ Select the application you want to close, and then select Stop to close it. 

■ Select Stop All to close all of your open applications.

NOTE You can also open the Memory Settings screen by pressing Option + OK, or by pressing Start, selecting Settings, 
selecting the System tab, and then selecting Memory. 
14



L E A R N I N G  T H E  B A S I C S
USING YOUR TODAY SCREEN

Your Today screen is your home base where you can quickly look up contacts, dial numbers, see 
appointments and the number of unread email messages, and even display a web page. 

To access your Today screen, press Phone/Send . 

NOTE Pressing Phone/Send while a phone number is highlighted dials the number. To access your Today screen when a 
phone number is highlighted, deselect the number and press Phone/Send, or press Start and select Today. 

■ Title bar and status info: See “Phone overview” on page 19 to learn about the icons that 
appear in this area.

■ Dial Lookup field: Begin typing the name or number you want to look up. See “Dialing by 
contact name” on page 23 for more info. 

■ Web Search field: Enter a word you want to find on the Internet and press Center to begin the 
search (data services connection required).

■ Speed dial buttons: Select the picture or button you want to dial. See “Creating a speed dial 
button” on page 32 to create your own.

Title bar and 
status info

Dial Lookup field

Web Search field

Speed dial 
buttons
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SYNCHRONIZING CONTACTS AND OTHER INFO

To synchronize your contacts and other personal information, you must first install the software 
from the CD that came with your smartphone and set up a connection between your computer 
and your smartphone. See the setup poster for instructions.

After you complete the setup process, each time you connect your smartphone to your computer 
it automatically synchronizes the items that are set to sync. You can customize the sync settings 
(see “Setting synchronization options” on page 73) or use the default settings to synchronize 
your info from the following applications:

1. Connect your smartphone to your computer. You should 
hear the ActiveSync® tone.

2. Look for the ActiveSync icon  at the top of your 
smartphone’s screen and the ActiveSync icon  in the 
taskbar on your computer.

■ If you don’t see the ActiveSync icon, make sure the 
desktop synchronization software that came with your 
smartphone is running on your computer. 

■ If you have any problems synchronizing, see the 
electronic User Guide for troubleshooting suggestions.

NOTE We recommend installing a backup program to preserve your data and settings if your smartphone is ever lost or 
stolen. A backup and restore program also protects your data during a hard reset. To download a free backup and restore 
program, visit www.palm.com/mytreo700wVerizon.
16

http://www.palm.com/mytreo700wVerizon
http://www.palm.com


L E A R N I N G  T H E  B A S I C S
MAXIMIZING BATTERY LIFE

Battery life depends on individual usage. When used as a smartphone, your smartphone battery 
provides up to 4.5 hours of talk time or up to 15 days of standby time. 

You can increase your smartphone’s battery life by following a few easy guidelines. Remember 
that battery life depends on how you use your smartphone.

■ Charge your smartphone whenever you’re at your desk, or charge it overnight each day. The 
battery in your smartphone has a much longer useful life when it is topped off frequently, 
versus charging it after it is fully drained.

■ Your smartphone’s wireless features (phone, email, messaging, and web) generally consume 
more power than the organizer features. 

■ If you spend a lot of time using the camera (if included), games, media players, eBooks, or 
other applications, keep an eye on the battery icon and charge when necessary.

■ If you don’t plan to use the wireless features on your smartphone for a while, put it into Flight 
mode. You can forward calls to a different number or let all calls be picked up by voicemail 
(see the electronic User Guide for details). To see if your smartphone is in Flight Mode, tap 
the phone-off icon . 

■ As with any mobile phone, if you are in an area with no wireless coverage, your smartphone 
searches for a signal, which consumes power. If you cannot move to an area of better 
coverage, temporarily turn off your phone (see “Turning your phone on and off” on page 3). 

■ Turn off your smartphone’s Bluetooth® wireless technology feature when you do not need to 
make a Bluetooth connection.
17



■ Turn down the screen brightness (see “Adjusting the brightness” on page 82).

■ Set your screen to turn off automatically after a shorter period of inactivity (see the User 
Guide for details). 

■ Keep your battery away from direct sunlight and other sources of heat. Temperatures over 
120 degrees Farenheit (50 degrees Celsius) can permanently reduce the capacity and life 
span of any lithium ion battery.

NOTE If the battery is fully drained, it may take a few moments for the indicator light to turn on while charging. Don’t worry; 
your smartphone stores your info safely until you recharge the battery. To avoid draining the battery, charge and synchronize 
every day, especially if you use your smartphone often.
18



U S I N G  Y O U R  P H O N E
U S I N G  Y O U R  P H O N E

PHONE OVERVIEW

You can monitor the status of several items using icons at the top of your Today screen:
0

You missed an incoming call.

You have a voicemail message.

You have a new email, text, or multimedia message.

An error occurred during synchronization.

You have more than one of the conditions listed above.

Your phone is on. The bars display the signal strength. The stronger the signal, the 
more bars that appear. If you are outside a coverage area, no bars appear.

Your phone is off.

You are outside a Verizon Wireless coverage area and roaming on another mobile 
service provider’s network. Data services may not be available when roaming.

A voice call is in progress.

You are in an area that supports NationalAccess (1xRTT) data services with average 
speeds of 60–80Kbps and bursts up to 144Kbps.
19



You are in an area that supports BroadbandAccess (EVDO) data services with 
average download speeds of 400–700Kbps, capable of reaching speeds up 
to1.8Mbps, and upload speeds up to 156Kbps.

A NationalAccess data call is in progress. You can make calls but you cannot 
receive calls—any incoming calls go to voicemail. When you make a call the data 
transmission is automatically interrupted.

A BroadbandAccess data call is in progress. You can still make or receive calls. 
When you make or receive a call, the data transmission is automatically interrupted.

Your phone is connected to a NationalAccess network, but you are not actively 
transmitting data. You can still make or receive calls.

Your phone is connected to a BroadbandAccess network, but you are not actively 
transmitting data. You can still make or receive calls.

Your Palm® Treo™ 700w smartphone is connected to a computer or network that is 
providing a data connection.

A data connection is not available or your phone is off.

Your smartphone’s battery is low.

Your smartphone’s battery is charging.

Your smartphone is connected to a power outlet and the battery is fully charged.

Network 
name

Your phone is on and you are in a Verizon Wireless coverage area. If you are 
outside a coverage area, No service or Roaming appears instead. When you turn off 
your phone, Phone Off appears instead.
20



U S I N G  Y O U R  P H O N E
What’s my number?
1. Make sure your phone is on (see “Turning your smartphone on/

off” on page 3). 

2. If you do not see your Today screen, press Phone/Send .

3. Press Menu .

4. Select Preferences > Phone Settings.

5. On the Phone tab, look for your phone number below the title 
bar.

6. Press OK .

NOTE If your phone number doesn’t appear on the Phone Settings screen, press OK, and then turn your phone off and back 
on again. Repeat steps 1–6. If your phone number still doesn’t appear, your phone has not been activated. Turn your phone 
off, wait a few hours, and then turn on your phone and repeat these steps. If your phone number still does not appear, please 
contact Verizon Wireless for assistance.

Voice privacy is preventing over-the-air eavesdropping. Appears during a call when 
this option is turned on and is available on the Verizon Wireless network.

Location privacy is off and your location is available to the Verizon Wireless 
network and other applications. 

The Bluetooth® wireless technology status indicator appears in gray when this 
feature is off, in blue when this feature is on, and in reverse blue when your 
smartphone is communicating with another Bluetooth device. 

A call is in progress and your smartphone is connected to a Bluetooth headset or 
car kit. 

Look here for your 
phone number
21



MAKING CALLS

Your smartphone offers several ways to make phone calls. Try them all and you’ll discover which 
methods you prefer.

NOTE Be sure you phone is on before you make calls using any of these methods (see “Turning your phone on and off” on 
page 3).

Dialing with the number pad
1. Go to your Today screen (see “Using your Today 

screen” on page 15).

2. Using the numbered keys on the keyboard 
(number pad), enter a phone number. 

3. Press Phone/Send  to dial.

NOTE You do not need to press Option to access the numbers on 
the keyboard. However, when dialing short numbers, such as 411, 
the number may conflict with a contact name. If this occurs, press 
Option to avoid starting a contact lookup. You can always dial 911 
without pressing Option first.
22



U S I N G  Y O U R  P H O N E
Dialing by contact name
You can look up contacts quickly by entering just a few letters of a contact’s name or phone 
number directly from your Today screen. Before you can dial a call by contact name, you must 
create some contacts (see “Adding a contact” on page 36) or import them by synchronizing (see 
“Synchronizing contacts and other info” on page 16). 

1. Go to your Today screen (see “Using your Today screen” on page 15). 

2. Using the keyboard, begin entering one of the following for the 
contact you want to call:

■ First name (JOH for John)

■ Last name (SMI for Smith)

■ First initial, a space, and then last initial (J S for John Smith)

■ First name and last name (JOH SMI for John Smith)

■ Phone number (you don’t need to press Option to access the 
number keys)

For example, entering SM finds both Smilla Anderson and John Smith. Entering SM A finds 
only Smilla Anderson.

3. Select the number you want to dial.

4. Press Phone/Send  to dial.

NOTE To clear the Dial Lookup field and start another Contacts search, press OK. To delete letters when correcting a 
misspelled name, press Backspace.
23



Dialing with a speed dial button 
Before you can use a speed dial button, you must create some speed 
dial buttons. See “Creating a speed dial button” on page 32. 

You can dial your speed dial buttons by doing any of the following:

■ Select a speed dial button with the 5-way, and then press Center.

■ Tap a speed dial button with the stylus. 

■ Press and hold a Quick Key that you assign to the speed dial 
button.

To see more speed dial buttons, highlight the picture speed dial area and press Right or Left 
repeatedly, or highlight the text speed dial area and press Up, Down, Right, or Left.

Dialing by company name

1. Press Start  and select Contacts.

2. Press Menu  and select View By > Company.

3. Press Phone/Send  to go to your Today screen.

4. Using the keyboard, begin entering the first few letters of the 
company name.

5. Select the number you want to dial.

6. Press Phone/Send  to dial.

NOTE Until you change the View By setting, your contact list (in the Contacts application) is also sorted by company name.
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Dialing from a web page or message
Your smartphone recognizes most phone numbers that appear in web 
pages or in messages (text, email, or multimedia). 

1. Use the 5-way to highlight the phone number you want to dial in 
the web page or message.

2. Press Center to open the Phone dialog box.

3. Select Yes to dial.

Redialing a recently called number
■ To dial the last number you called: Go to your Today screen, 

and then press and hold Phone/Send .

■ To select from your most recently dialed numbers: Go to your 
Today screen, press Phone/Send , highlight the number 
or contact name you want to call, and then press Phone/
Send  to dial. 

■ To select from a chronological list of calls: Go to your Today 
screen, press Phone/Send , and then select Call Log. 
Highlight the number you want to call, and then press Call 

 to dial. 

NOTE You can also access the Call Log by going to the Today screen, pressing 
Menu, and then selecting Call Log.
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Dialing using the onscreen Dial Pad
The onscreen Dial Pad is useful for dialing numbers that are 
expressed as letters, such as POPCORN to check the time, and when 
you need large numbers that you can tap with your finger or stylus. 

1. Go to your Today screen. 

2. Press Phone/Send  and then select Dial Pad from the menu.

3. Tap the onscreen Dial Pad to enter the number.

4. Press Phone/Send  to dial.

NOTE You can paste numbers directly into the Dial Pad. Copy a number from another application, switch to Dial Pad, and 
then press and hold Center to paste the number. You can also access the Dial Pad by going to the Today screen, pressing 
Menu, and then selecting Dial Pad.

RECEIVING CALLS

To receive calls, your phone must be on. This is different from using your smartphone in Flight 
mode.

■ To answer a call, do one of the following:

■ Press Phone/Send .

■ Press Answer .

■ If the headset is attached, press the headset button.
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■ To ignore a call, do one of the following:

■ Press Power/End .

■ Press Menu  and select Ignore.

■ Press Menu  and select Ignore with text message.

■ To silence the ringer while your smartphone is ringing:

■ Press the Volume button or any key on your smartphone except Phone/Send, Power/End, 
or the 5-way.

■ To immediately silence all system sounds including the ringer, slide the ringer switch to 
Sound Mode Off . All sounds remain off until you slide the ringer switch back to Sound 
On .

NOTE When you silence the ringer, you can either answer the call or let it ring through to voicemail. 

USING VOICEMAIL

Setting up voicemail
1. Go to your Today screen.

2. Press and hold 1 on the keyboard to dial Verizon Wireless’s 
voicemail system.

3. Follow the voice prompts to set up your voicemail.
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Retrieving voicemail messages
When you have unretrieved voicemail messages, a Voicemail icon  appears at the top of your 
screen and the left action key is labeled Voicemail.

1. Go to your Today screen.

2. Press and hold the 1 key (or tap Voicemail  or press Voicemail ) to dial Verizon 
Wireless’s voicemail system.

3. Enter your voicemail password using the keyboard, or press Extra Digits  if you defined 
this option (see “Creating a speed dial button” on page 32 for details).

4. Select Play  to listen to your messages.

NOTE You don’t need to press Option to enter numbers, *, or # when responding to voicemail prompts.

MANAGING ACTIVE CALLS

When you make or receive a call, the active call info appears on 
your Today screen. 

During a call, you can do any of the following:

■ Put the call on hold: Press Hold . To take the call off 
hold, press Off Hold .

■ Use the built-in speakerphone: Press Menu  and select 
Speakerphone. To return to the earpiece, press Menu  
again and select Speakerphone off. Current duration 

of call
Caller’s name 
and number
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■ Mute the microphone so you can’t be heard: Press Menu  and select Mute. To turn the 
microphone back on, press Menu  again and select Cancel Mute.

■ Switch to another application: Press Start  and select the application.

NOTE When a call lasts longer than one minute, the screen dims and then turns itself off. Press any key, except Power/End, 
to wake up the screen.

Adjusting call volume
While a call is in progress, press the Volume button on the side of your smartphone to adjust 
call volume.

Ending a call
Do one of the following:

■ Press Power/End .

■ Press the headset button (if the headset is attached).

Volume button
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Returning to an active call from another application
You can use many other applications on your smartphone while holding a phone conversation, 
including the organizer and SMS features. You cannot browse the web or send and receive email 
or MMS messages while on a voice call.

From any application, press Phone/Send  to return to your Today screen.

Saving phone numbers
After you complete a call, you are prompted to add the number if it isn’t in your Contacts list. 

■ To create a new contact for this number, select Create New Contact.

■ To add this number to an existing contact, select Copy and Add, and then select a contact.

■ To decline adding the number, press Dismiss .

■ To permanently disable the Add Contact prompt, select Don’t show this again.

If you don’t add a number right away, follow these steps to add it later: 

1. Go to the Call Log (see “Redialing a recently called number” on page 25). 

2. Highlight the number you want to save. 

3. Press and hold Center to open the shortcut menu, and then select Save to Contacts.

4. Enter the information for the entry.

5. Press OK .

NOTE You can also save contact info from other applications, such as Messaging. If an incoming call uses caller ID 
blocking, you do not see the Add Contact prompt.
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Answering a second call (call waiting)
When you’re on a call and you receive a second call, the call waiting notification appears. When 
the second call is incoming, you can swap between the two calls, but you can’t conference them.

You can do any of the following:

■ Place the current call on hold and answer the new call: 
Press Answer  or Phone/Send .

■ Send the new call to voicemail: Press Menu  and select 
Ignore.

■ Send the new caller a text message: Press Menu  and select 
Ignore with text message.

■ Hang up both calls: Press Power/End .

NOTE When two calls are active and you press Power/End, you hang up both calls. To return to the first call, wait for the 
person on the second call to hang up.

Making a conference call
When the second call is outgoing, you can join two calls in a conference session. Additional 
charges may apply and minutes in your mobile account may be deducted for each active call. 
Please contact Verizon Wireless for more information. 
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1. Put the first call on hold, and then place a second call.

2. Press Conference ; this joins the two active calls in a 
conference.

3. When you’re done, press End Conference ; this ends the 
second call and returns you to the first call. If you’re ready to hang 
up both calls, press Power/End  instead.

CREATING A SPEED DIAL BUTTON

You can create up to 20 picture buttons and 50 text buttons. 

1. Go to your Today screen.

2. Press Menu  and select New Speed Dial. 

3. Do one of the following:

■ Select Link to contact, select the contact you want to link to 
this button, and then select the number you want to dial with 
this button.

■ Select Label and enter a name for this button, and then select 
Number and enter the phone number you want to dial with this button.

4. (Optional) Enter a Quick Key. When the Today screen is showing, you can press and hold the 
Quick Key to instantly dial this number.
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5. If this button is linked to a contact entry with a picture, select either Text Speed Dial or Picture 
Speed Dial to indicate which type of button you want to create. If this button is not linked to a 
contact or the contact doesn’t have a picture, the Picture Speed Dial option is not available.

6. (Optional) Select the Advanced tab and set any of the following options:

■ Extra Digits: Defines additional numbers to dial, such as a password or extension. In 
addition to numbers, you can enter the following symbols: star (*) and pound (#). To 
enter a one-second pause, enter a comma (,). 

■ Dial extra digits automatically: Dials predefined Extra Digits 
immediately after dialing the phone number. If you do not 
check this box, you need to press Extra Digits  to dial 
these digits.

■ Show voice mail buttons: Displays the voicemail playback 
controls after you dial this speed dial number. When this 
option is checked, you can enter numbers below each control 
to tailor the controls to your voicemail system.

 Plays the previous message.
 Saves the current message.
 Plays the current message.
 Deletes the current message.
 Repeats the current message.
 Plays the next message.

7. Press OK . 

NOTE To edit a speed dial button, highlight the button, press and hold Center, and then select Edit Speed Dial from the 
shortcut menu.
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USING A PHONE HEADSET

You can connect a phone headset for hands-free operation. If you need to use your smartphone 
while driving and this is permitted in your area, we recommend using a phone headset or a 
hands-free car kit (sold separately).

The headset button is context sensitive and it performs different actions based on the situation. 
You can press the headset button to perform any of the following tasks:

■ Answer an incoming call

■ Answer a call waiting call

■ Hang up all calls

Microphone

Speaker

Headset button
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Headset specifications
Your smartphone works with headsets that have a 2.5mm, 3-pin connector. When in doubt, ask 
the third-party headset manufacturer if the product is compatible with Treo 700w smartphones. If 
you hear a headset buzz or poor microphone performance, your headset may be incompatible 
with your smartphone.

Using a hands-free device with Bluetooth wireless technology
Your Treo smartphone is also compatible with many headsets and car kits enabled with Bluetooth 
wireless technology version 1.1 or 1.2. Please note, however, that you cannot use a Bluetooth 
headset to listen to MP3 files on your smartphone. 

[ ! ] IMPORTANT For a list of compatible hands-free devices with Bluetooth wireless technology, go to: 
www.palm.com/mytreo700wVerizon.

To learn how to set up and connect to Bluetooth devices, see “Setting up a Bluetooth® 
connection” on page 56. Here are tips for working with a Bluetooth hands-free device:

■ To transfer a call from a wired headset to a Bluetooth headset that is within range and with 
which you’ve previously set up a partnership (Bluetooth headset required, sold separately), 
unplug the wired headset and press the button on the Bluetooth headset. 

■ To transfer a call from the handset to a Bluetooth hands-free device during a call, press Menu 
 and select Connect. To transfer the call back to the Bluetooth hands-free device, press 

Menu  and select Cancel Bluetooth.

NOTE If you have both a compatible Bluetooth headset and car kit, the one you connected to your smartphone last 
becomes the active device.
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This section introduces you to a few of the applications you can use to stay organized. To learn 
about the other applications that come with your smartphone, such as Tasks and Notes, see the 
User Guide.

CONTACTS

Adding a contact
If you have many contacts to enter, it’s best to enter them in Microsoft® Office Outlook® on your 
computer and then sync. See “Synchronizing contacts and other info” on page 16 for details. To 
enter a few contacts, follow these steps:

NOTE Be sure to enter mobile numbers and email addresses in the correct fields. Otherwise Messaging can’t find this info 
when you address a message, and Calendar can’t find your contacts to invite them to meetings.

1. Press Start  and select Contacts.

2. Press New .

3. Use the 5-way to move between fields as you enter information.

4. To add a caller ID picture that appears when that person calls, 
select Picture, and then select Camera and take a picture, or 
select an existing picture from the Thumbnail screen. 

5. To assign the entry to one or more categories, select Categories 
and then check the categories under which you want this entry to appear.

6. To add a note to an entry, select the Notes tab.
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7. To assign a ringtone to the entry, select Ring tone and select a tone.

8. After you enter all the information, press OK . 

Viewing or changing contact information
1. In the Contacts list (name view), begin entering one of the following for the contact you want 

to view or edit:

■ First name

■ Last name

■ First initial and last initial separated by a space

■ Phone number

2. Select the entry you want to open.

3. Press Menu  and select Edit.

4. Make changes to the entry as necessary.

5. Press OK .

CALENDAR

Displaying your calendar

1. Press Start  and select Calendar.

2. Press Menu  and select View.
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3. Select one of the following views:

■ Agenda: Shows your daily schedule in list format. Upcoming appointments are bold, past 
appointments are dimmed.

■ Day: Shows your daily schedule in day-planner format.

■ Week: Shows your schedule for an entire week.

■ Month: Shows your schedule for a whole month. 
 A morning appointment. 
 An afternoon appointment. 
 There are both morning and evening appointments. 
 An all-day event.

■ Year: Shows a calendar for a 6-month period.

4. Use the 5-way to move to another day, week, month, or year (based on the current view).

Creating an appointment
If you have several appointments to enter, it’s most efficient to enter them in Microsoft Office 
Outlook on your computer and then synchronize your smartphone with your computer. See 
“Synchronizing contacts and other info” on page 16 for details.

1. Press Start  and select Calendar.

2. Press Menu  and select New Appointment.

3. Enter a subject (description) and a location.

4. Select Starts and select the starting date and time.
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5. Select Ends and select the ending date and time.

6. (Optional) Set an alarm:

■ Select Reminder, and then select Remind Me.

■ Enter the number of minutes, hours, days, or weeks before 
the event you want to receive the alarm.

7. Press OK . 

NOTE See the User Guide to learn how to change the alarm tones.

Sending a meeting request
You can email meeting invitations to contacts who use Microsoft 
Office Outlook or Outlook Mobile. 

NOTE Create contact entries with email addresses for the people you want to invite to a meeting. You can’t access contact 
entries without email addresses from your calendar.

1. Create an event, and then select it.

2. Press Edit . 

3. Select Attendees, and then select the name of the contact you want to invite. To invite other 
attendees, select Add and select the names. 

4. Press OK .

The next time you synchronize, the meeting request is sent to the attendees. When attendees 
accept your meeting request, the meeting is automatically added to their schedules. When you 
receive their response, your calendar is updated as well.

Type of 
time units

Number of 
time units
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MESSAGING

You can use the Messaging application to exchange email, text messages (SMS), and multimedia 
messages (MMS) with other mobile devices and email addresses that support these forms of 
messaging. You can also exchange instant messages (IM) with Pocket MSN. Before you use your 
smartphone’s messaging features, consult Verizon Wireless for pricing and availability.

Setting up an email account
Before you set up your email account(s) on your smartphone, you must determine which type of 
account(s) you want to access, as the steps vary for each account type. The following gives an 
overview of the account types, and setup steps for each account type appear later in this section:

■ Exchange Server: Enables you to wirelessly synchronize your email and other information 
directly with the information stored on a Microsoft Exchange 2003 Server.

■ Wireless Sync: Enables you to use a Verizon Wireless Sync account to wirelessly synchronize 
your email and other information with the information stored on your computer (Verizon 
Wireless Sync account required, additional charges may apply).

■ IMAP or POP: Enables you to send and receive email messages with a corporate email 
account or an account that you have with an Internet service provider (ISP).

■ Hotmail: Enables you to send and receive email messages with an MSN Hotmail account. 

NOTE If your email account requires a VPN connection to establish a secure connection, you must install a VPN application 
(sold separately) on your smartphone before you can access your email. Visit www.palm.com/mytreo700wVerizon to 
purchase a VPN application, and see the electronic User Guide for more info.
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Setting up an Exchange Server email account

If you already set up your Exchange Server email settings when you installed the ActiveSync® 
desktop software, you do not need to repeat this process. If you did not set up an Exchange 
Server email account, follow the steps in this section to set up an account now. Work with your 
system administrator to gather the following info:

■ Mail server address and domain name

■ Your username and password

NOTE The Exchange Server settings are case sensitive. Be sure to enter uppercase and 
lowercase letters properly.

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu  and select Add Server Source. 

4. Enter the Server address, and then press Next . 

5. Enter your username, password, and domain. 

6. If you want to enter your password each time you access this 
account, do not check the Save password box. If you want your 
password entered automatically, check this box.

7. (Optional) Select Advanced to set the rules for fixing sync 
conflicts.
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8. Press Next  and check the boxes for the types of 
information you want to synchronize with Exchange Server. 

9. (Optional) Highlight an item and select Settings to change the 
synchronization settings for that type of information. 

NOTE Settings are not available for all items. If you want to download more than the 
email message header, select E-mail and increase the KB setting. If you don’t increase 
this setting, you can manually download the rest of the message at your convenience.

10. Press Finish . 

Setting up a Wireless Sync email account
To use Wireless Sync, you must first install the desktop synchronization software that came with 
your smartphone, and you must subscribe to Verizon Wireless’s Wireless Sync feature 
(additional charges may apply).

1. If you haven’t already done so, go to http://www.wirelesssync.vzw.com to do the following:
■ Create your Wireless Sync account. Click Register and then Setup Wireless Sync Now.

■ Make sure your phone is on (see “Turning your smartphone on/off” on page 3), click Next 
and then follow the onscreen instructions.

■ When prompted, enter a temporary password and then select an official password.
■ Indicate which email accounts you want to use with this feature. (This may require info 

about your mail server from your system administrator.)
■ Install the Wireless Sync desktop software.

2. On your smartphone, press Start  and select Programs.
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3. Select Wireless Sync .

4. Press Start  and then wait a few minutes for the installation to complete.

5. When the following message appears on your smartphone screen: Have you created your 
Wireless Sync account yet?, select Yes.

6. Select Sync near the top of the screen.

7. When the Authentication dialog box appears, enter the password for your Wireless Sync 
account.

8. When the First Synchronization dialog box appears, do one of the following based on the type 
of email account you set up:
■ Corporate email or Both: Select Refresh.
■ Internet email: Select Merge.

For corporate email accounts, the default settings do a wireless sync whenever info changes in 
Microsoft® Office Outlook®. To find out how often you can expect message delivery, contact your 
system administrator and ask about your company’s server settings. For Internet email accounts, 
the default settings do a wireless sync every 30 minutes. To customize your Wireless Sync 
settings, select Setup at the bottom of the screen, and then select Push/ReadySync.

Setting up an IMAP or POP email account
You can send and receive email messages with an email account that you have with an Internet 
service provider (ISP), an email account that you access using a VPN server connection (such as 
a work account), or any other IMAP (Internet Message Access Protocol) or POP email account. 
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Work with your system administrator to gather the following info:

■ Account type (POP3 or IMAP)

■ Mail server name for receiving mail

■ Mail server name for sending mail

■ Your username and password

■ Domain name

■ Any special security requirements

1. Go to your Today screen and press Messaging .

2. Press Menu  and select Tools > New Account.

3. Enter the email address that you want to set up, and then press 
Next .

4. Wait until the Status box displays Completed, and then press 
Next .

5. Enter your name, username, and password.

6. If you want to enter your password each time you access this 
account, do not check the Save password box. If you want your 
password entered automatically, check this box.

7. Press Next .

8. Select the Account type list, and then POP3 or IMAP.
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9. Enter a name for this account, and then press Next . For example, if this is your work 
email account, enter “Work” or your company’s name.

10. Enter the name of the incoming mail and outgoing mail servers and the domain.

11. (Optional) Select Options to set this account’s download options.

12. Press Finish .

NOTE To delete an email account, press Menu and select Tools > Options. Highlight the account you want to delete. Press 
and hold Center, and then select Delete.

Signing in to Pocket MSN
Pocket MSN provides quick access to the following:

■ MSN Hotmail: Lets you read, write, send, and delete email, and manage your Hotmail folders.

■ MSN Messenger Contacts list: Lets you see who’s online and exchange instant messages 
(IM). Subscribe to status updates for selected contacts so you’re notified when they’re online.

■ Options: Lets you customize your Pocket MSN experience.
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1. Press Start  and select Pocket MSN.

2. Select MSN Mobile Home.

3. Select Sign in.

4. Enter the email address and password for your Passport account 
or your Hotmail account. 

■ To create a Passport (IM) account, go to www.passport.com.

■ To create a Hotmail account, go to www.hotmail.com.

Creating and sending an email message
1. Go to your Today screen and press Messaging .

2. Press Left  to cycle through your Messaging accounts until you see the email account you 
want to use in the title bar.

3. Press New .

4. Do one of the following to address the message:

■ If the recipient’s name and email address are in your Contacts 
list, enter the first few letters of the recipient’s first or last 
name, and then select the recipient’s name.

■ If the recipient’s name and email address are not in your 
Contacts list, enter the full email address. 

NOTE To send a message to multiple recipients, separate the addresses with a 
semicolon (;).
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5. Select Subject and enter a title for the message.

6. Enter your message, or press Menu , select My Text, and then select a predefined 
phrase you want to insert. 

7. (Optional) Do any of the following:

■ Press Menu  and select Insert. Select the type of item you want to attach, and then 
select the file or record a voice note. 

■ Press Menu  and select Spell Check.

■ Press Menu  and select Message Options. Select the Priority list, select a setting for 
the message, and then press OK .

8. Press Send .

NOTE If you have difficulty sending mail, try changing your outgoing mail settings to the following: 
User name: [9-digit phone number]@vzwmail.net (6505551212@vzmail.net), Password: Your www.vtext.com password, 
Outgoing Server: smtp.vzwmail.net. For details on accessing these settings, see “Finding Help” in the User Guide. To keep a 
copy of your outgoing messages in the Sent folder, you must turn on this setting. See “Customizing your Messaging 
settings” in the User Guide for details.

Synchronizing your email
During synchronization, new messages are copied to your smartphone’s Inbox, and messages in 
the smartphone’s Outbox are sent. Your computer must be connected to the Internet when you 
sync your email.

To sync your default email account, simply sync your smartphone with your computer. See 
“Synchronizing contacts and other info” on page 16 for details. To sync additional email 
accounts, such as an Internet Service Provider (ISP) account or a work account that you access 
using a VPN server connection, follow these steps:
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1. Go to your Today screen and press Messaging .

2. Press Left  to cycle through your Messaging accounts until you see the account you want to 
download in the title bar.

3. Press Menu  and select Send/Receive to sync your smartphone with your email server.

Receiving attachments
1. Select the attachment (below the subject) to mark it for download.

2. Sync the email account that contains the message (as described in the previous sections).

3. Select the attachment to open it.

To automatically download attachments from an Outlook E-mail account, do the following: 

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu  and select Options. 

4. Select E-mail, and then select Settings.

5. Check the Include file attachments box, and then press OK .

To automatically download attachments from an IMAP4 email account (typically an ISP account) 
or an account that you access using a VPN server connection, do the following: 

1. Go to your Today screen and press Messaging . 

2. Close any open messages, and then press Menu  and select Tools > Options.
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3. On the Accounts tab, select the IMAP4 account name. 

4. Press Next  until you reach Server information, and then select Options. 

5. Press Next twice, and then select Get full copy of messages and When getting full copy, get 
attachments. 

Creating and sending a text message
Each text message can hold up to 160 characters. To save time, you can select from predefined 
My Text phrases, such as “Call me” or “On my way.” You can add your own My Text phrases, and 
if you prefer, you can enter the full message text too.

1. Go to your Today screen and press Messaging .

2. Press Left  until you see Text Messages in the title bar.

3. Press New .

4. Do one of the following to address the message:

■ If the recipient’s name and mobile number are in your 
Contacts list, press Center, enter the first few letters of the 
first or last name, and then select the name.

■ If the recipient’s name and mobile number are not in your 
Contacts list, enter the full mobile number. 

NOTE To send a message to multiple recipients, separate the addresses with a 
semicolon (;). If you send a message to three people, you are billed for three messages.

5. Enter your message, or press Menu , select My Text, and then select a predefined 
phrase you want to insert. 
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6. (Optional) Press Menu  and select Spell Check.

7. (Optional) Press Menu  and select Message Options. Enter a callback number and then 
select OK.

8. Press Send .

Creating and sending a multimedia message
Multimedia messages can include any of the following items presented as one or more slides:

NOTE Even if your smartphone does not include a camera, you can still send, receive, and view pictures and videos.

1. Go to your Today screen and press Messaging .

2. Press Left  until you see MMS in the title bar.

3. Press New .

4. Do one of the following to address the message:

■ If the recipient’s name and mobile number or email address are in your Contacts list, 
press Center, select Add Recipient, enter the first few letters of the recipient’s first or last 
name, and then select the recipient’s name.

■ Ringtones

■ MIDI

■ Sound clips

■ WAV

■ QCELP

■ Pictures

■ JPEG

■ GIF

■ BMP

■ Videos

■ 3G2
50



S T A Y I N G  I N  T O U C H
■ If the recipient’s name and mobile number or email address are not in your Contacts list, 
enter the full mobile number or email address. 

■ If you want to upload a picture or video to your Verizon Wireless PIX Place account, press 
Center, and then select PixPlace.

NOTE To send a message to multiple recipients, separate the addresses with a semicolon (;). If you send a message to 
three people, you are billed for three messages.

5. Select Subject and enter a title for the message.

6. Select New Slide.

7.  Press Center and select one of the following:

■ Add Picture: Lets you insert a picture. You can take the 
picture with the built-in camera or insert an existing picture.

■ Add Video: Lets you insert a video. You can capture a video 
with the built-in camera or insert an existing video clip. If you 
insert a video, you cannot add a sound to the same slide; to send a sound, add another 
slide to your message.

■ Add Sound: Lets you record a message, such as a voice caption for a picture, or insert an 
existing sound, such as a ringtone. You can add one sound per slide; to send more than 
one sound in a message, add another slide to your message. If you capture a picture with 
the built-in camera and save it with a voice caption, the voice caption does not count as a 
sound file. 

8. Enter a text caption or message for the item you inserted.

9. Select Next  and repeat steps 8–9 to add other items in this message.
51



10. (Optional) Select Play  to view the message as the recipient will see it.

11. When you’re done creating the message, press OK .

12. Press Send .

Receiving text and multimedia messages
When your phone is on and in a wireless coverage area, you automatically receive new text 
messages. For multimedia messages, you can set your smartphone to automatically download 
new messages or to notify you that messages are ready to download. You can also set your 
smartphone to notify you when a new text or multimedia message arrives.

The new message notification may include any of the following options:

■ View: Opens the message so you can view its full contents.

■ Download: Downloads the rest of the message from the server. 

■ Reply: Opens a message addressed to the sender’s phone number.

■ Dismiss: Closes the notification and puts the message in your Inbox.

■ Menu: Opens a menu where you can select other options.
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Viewing/playing a multimedia message
1. Go to your Today screen and press Messaging .

2. Press Left  until you see MMS in the title bar.

3. From the Inbox, select the message you want to view. 

4. If you’re viewing the message for the first time, playback begins 
automatically. Otherwise, select an item to play.

5. Do any of the following:

■ Go the previous or next slide: Tap Previous  or Next .

■ Pause or resume playback: Tap Pause  or Play . 

■ Save the item that is playing: Press Menu  and 
select Save.

■ Go to the top of the message: Press Menu  and select Message Overview.

■ Reply to the message: Press Menu  and select Reply or Reply All.

■ Call the sender: Press Menu  and select Call Sender.

■ Save the message as a template for other messages: Press Menu  and select Save to 
Template.

6. Press OK .
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BROWSING THE WEB

Internet Explorer Mobile provides quick and easy access to web pages. You can view most sites 
you use on your computer, including those with security and advanced features, such as 
JavaScript and frames. To browse the web, you must subscribe to data services from Verizon 
Wireless. 

Viewing a web page
By default, Internet Explorer Mobile scales web page content to fit your smartphone screen so 
that you can view most of the information without scrolling left or right.

1. Make sure your phone is on (see “Turning your phone on and off” 
on page 3).

2. Press Start  and select Internet Explorer.

3. Highlight the address line, enter the address of the web page you 
want to view, and then press Center. 

4. Press Menu , select View, and then select one of the 
available formats.

5. Do any of the following:

■ To view the previous page, press Back  or press Backspace .

■ To refresh the page with the latest content from the Internet, press Menu  and select 
Refresh.
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■ To follow a link to another web page, press Up  or Down  to highlight the link, and 
then press Center to go to the selected page. You can also tap the link on the screen with 
your stylus.

■ To adjust the size of the text on web pages, press Menu , select Zoom, and then 
select the size you want.

■ To view a web page’s properties, press Menu  and select Tools > Properties.

6. Press OK  to close Internet Explorer Mobile.

Creating a favorite
Favorites let you bookmark a web page so that you can instantly access it without entering the 
web address. Be sure to check out the built-in favorites for cool downloads.

1. Create the folders where you want to store your favorites. (Once you create a favorite, you 
can’t move it to another folder.)

2. Go to the page you want to mark as a favorite. 

3. Press Menu  and select Add to Favorites.

4. (Optional) Select Name and enter a different description.

5. (Optional) Select the folder where you want to create the favorite.

6. Select Add.
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Downloading files and images from a web page
You can download files that are usable on your smartphone, such as new applications, MIDI 
ringtones, or pictures that are specifically tagged for download. 

1. Go to the page that contains the link to the file you want to download.

2. Press Left  or Right  to highlight the link to the file.

3. Press and hold Center, and then select Save As to download a file, or tap and hold and select 
Save Image to download an image.

4. Select Name and enter a new name for the file. 

5. Select the Folder list, and then select the folder where you want to save the file. 

6. Select the Location list, and then select where you want to store the file: Main memory or 
Storage card. 

7. Press OK .

SETTING UP A BLUETOOTH® CONNECTION

With your smartphone’s built-in Bluetooth® wireless technology, you can connect to a number of 
Bluetooth devices such as a headset, hands-free car kit, or GPS receiver, as well as to other 
phones, handhelds, or piconets. If your computer is enabled with Bluetooth wireless technology, 
you can also synchronize wirelessly.

[ ! ] IMPORTANT For a list of hands-free devices with Bluetooth wireless technology that are compatible with your 
smartphone, go to www.palm.com/mytreo700wVerizon.
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S T A Y I N G  I N  T O U C H
After you set up a connection with a Bluetooth device, you can 
communicate with that device whenever it is within range (about 
30 feet) and your smartphone’s Bluetooth feature is turned on. 

1. If necessary, prepare the device you want to connect with to 
accept a new connection. Check the device’s documentation 
for details.

2. Go to your Today screen, and then tap Bluetooth .

3. Check the Turn on Bluetooth box to turn on your 
smartphone’s Bluetooth feature.

4. Select the Devices tab, and then select New Partnership.

5. Wait for your smartphone to search for devices and to display 
the device list.

6. Select the device you want to connect with, and then press 
Next .

7. Enter an alphanumeric passkey between 1 and 16 characters 
long, and then press Next .

[ ! ] IMPORTANT Some Bluetooth devices have a built-in passkey; others let 
you choose the passkey. See the documentation for the Bluetooth device for more 
info.

8. If the passkey is not built-in, enter the same passkey on the 
Bluetooth device, and then press Finish .
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9. If you’re connecting to a headset or hands-free car kit, check the Hands Free box, and then 
press Finish . 

10. If you’re connecting to a GPS device, press Finish , select the COM Ports tab, select the 
GPS device you selected in step 6, and then select New Outgoing Port. Press Finish .

11. Press OK .

12. If you’re connecting to a GPS device, enter your GPS Settings (see the electronic User Guide 
for more info). Be sure to select the same port you selected in step 10. 

You can now communicate with this device whenever it is within range (about 30 feet) and your 
smartphone’s Bluetooth feature is turned on (see steps 1 and 2 earlier in this section). If you’re 
using a hands-free Bluetooth device and it is within range (30 feet), your smartphone routes all 
calls to the hands-free device instead of your smartphone’s earpiece. When a call comes in, your 
smartphone rings and the car kit or headset beeps. Even if you pick up the call on your 
smartphone earpiece, the call goes to the headset or car kit.
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Beaming a record
1. Highlight the entry or file you want to beam.

2. Press Menu  and select Beam… (the menu item changes names based on the type of 
item you highlighted).

3. Do one of the following:

■ Bluetooth: When the name of the receiving device appears, tap the Tap to send link to 
begin the transfer.

■ Infrared: Point the IR port on your smartphone directly at the IR port of the receiving 
device.

4. Wait for “Done” to appear next to the name of the receiving device before you continue using 
your smartphone.
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PICTURES & VIDEOS

Your smartphone comes with a built-in, 1.3-megapixel camera with 2x digital zoom (camera not 
included with all smartphones). You can use the camera to take, view, and send pictures and 
videos, and to add a personal touch to your smartphone, use your pictures as your Today screen 
background and as caller ID images, or use your videos to create video ringtones.

Taking a picture
By default, pictures are stored in the My Pictures folder on your smartphone. If you want to store 
your pictures on an expansion card, see the electronic User Guide for instructions.

1. Press Start  and select Pictures & Videos. 

2. Select Camera .

NOTE If you see a camcorder icon below the preview image, video mode is on. To turn 
on the still camera, press Menu and select Still Mode. If you don’t see a camcorder icon, 
skip this step.

3. Adjust the position of your smartphone until you see the subject 
you want to photograph on the screen.

4. (Optional) Adjust any of the following:

■ Zoom: Press Up  to zoom in or Down  to zoom out.

■ Brightness: Press Right  to increase the brightness or Left  to decrease the brightness.

■ Resolution: Press Menu  and select Resolution to change the image quality.
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5. Press Center to capture the picture.

6. Hold your smartphone still until the picture renders, and then do one of the following:

■ Press Camera  to take another picture.

■ Press OK  to return to the Thumbnails View. 

Recording a video
Videos can be any length, provided you have ample storage space available. By default, videos 
are stored in the My Pictures folder on your smartphone. If you want to store your videos on an 
expansion card, see the electronic User Guide for instructions. 

1. Press Start  and select Pictures & Videos.

2. Select Camera .

3. Press Menu  and select Video Mode.

4. Adjust the position of your smartphone until you see the subject you want to record on the 
screen.

5. (Optional) Adjust any of the following:

■ Brightness: Press Right  to increase the brightness or Left  to decrease the brightness.

■ Resolution: Press Menu  and select Quality to change the video resolution.

6. Press Center to start recording.
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7. When you’re done recording, press Stop  or Center to 
stop recording.

8. (Optional) To review the video in Windows Media Player 
Mobile, press Thumbnails , highlight the video, and then 
press Center. Press OK  to return to the Thumbnail View in 
Pictures & Videos. 

Viewing a picture or video

1. Press Start  and select Pictures & Videos.

2. Select the picture or video you want to view. For more info on viewing videos, see “Playing 
media files on your smartphone” on page 64.

3. Press OK  to return to the Thumbnail View.

NOTE To view pictures or videos in a different folder, go the Thumbnail View, select the Show list in the upper left, and then 
select the album you want to view. 

Creating a video ringtone
You can save a video that you record as a ringtone.

1. Press Start  and select Pictures & Videos.

2. Highlight the video you want to use as a ringtone. 

3. Press Menu  and select Save to Contact Ring Tone.

4. Select the contact you want to assign the ringtone to.
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WINDOWS MEDIA PLAYER MOBILE

Windows Media Player Mobile can play music, audio, and video files that are stored on your 
smartphone or on an expansion card (sold separately) in any of the following file formats: WMA, 
WMV, MP3, and 3G2.

Transferring media files to your smartphone
Use the Sync feature in the desktop version of Windows Media Player 10 to transfer compatible 
media files from your computer to an expansion card or your smartphone. Using the Sync feature 
ensures that the files and album art transfer correctly.

1. On your computer, open Windows Media Player 10.

2. (Optional) Insert a 32MB or larger expansion card into your smartphone.

3. Connect your smartphone to your computer with the USB sync cable. 

4. When the Device Setup Wizard opens on your computer, click Automatic. 

5. Check the Customize the playlists that will be synchronized box.

6. Select the playlists you want to sync.

7. Click Finish to begin the transfer. The next time you connect your smartphone to your 
computer while the desktop version of Windows Media Player 10 is running, synchronization 
starts automatically.

NOTE Be patient; transferring media files can take several minutes. 
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Playing media files on your smartphone
You can listen to media files through the speaker on the back of your smartphone or through a 
stereo headphone (3.5mm stereo headphone adapter or 2.5mm stereo headphone required, sold 
separately).

NOTE If you can’t find a media file on your expansion card, update the library (see “Working with libraries” on page 65).

1. Press Start  and select Windows Media.

2. Press Menu  and select Library.

3. Do one of the following:

■ To play a file from a library, select the Library list in the upper left, and then select the 
library you want to use. 

■ To play a file that is not in a library, press Menu  and select Open File. 

■ To play a file from the web, press Menu  and select Open URL. Select URL and enter 
the website address, or select History and select a site you’ve visited before.

4. Select the item you want to play, and then press Play .

5. Use any of the following hardware or onscreen controls during playback:
Center or  Plays the current file.
Center or  Pauses the current file.
Left  or  Skips to the beginning of the current file or to the previous file.
Right  or  Skips to the next file.

 Sets the point where playback begins. Tap and drag the slider to change the position.
Volume button or  Increases the volume level.
Volume button or  Decreases the volume level.
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 Turns the sound on or off.
 Displays a video using the full screen.
 Displays a website where you can find music and videos to play.
 Indicates the rating of the current file. Select the star to change the rating.

6. Press Menu  and select any of the following during playback:

■ Library: Displays the Library screen so you can select a different song to play.

■ Shuffle/Repeat > Shuffle: Plays the Now Playing playlist in random order. A check appears 
next to this command when it is on.

■ Shuffle/Repeat > Repeat: Plays the Now Playing playlist repeatedly. A check appears next 
to this command when it is on.

■ Stop: Ends playback.

Working with libraries
A library represents a media storage location, so you should have two libraries: My Device and 
My Storage Card. Each library contains links to the media files in that location. Windows Media 
Player Mobile usually updates the My Device library automatically, but you must manually update 
the My Storage Card library. 

1. Press Start  and select Windows Media.

2. Press Menu  and select Library.

3. Press Menu  and select Update Library.

4. Wait for the files to be added, and then select Done.
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WORD MOBILE

You can create and edit documents and templates and save them as DOC, RTF, TXT, and DOT 
files. You can also edit Microsoft® Office Word® documents and templates that you create on 
your computer. However, keep in mind that some of the information and formatting may be lost 
when you save the document on your smartphone. See your User Guide for details on supported 
and unsupported features.

Creating a document

1. Press Start  and select Programs.

2. Select Word Mobile .

3. Press New .

4. Enter the text of the document.

5. Press OK  to save the file.
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POWERPOINT MOBILE

With PowerPoint Mobile, you can open and view slide show presentations created on your 
computer. Many presentation elements such as slide transitions, animations, and URL links are 
also supported. See your User Guide for details on supported and unsupported features. 

Playing a presentation

1. Press Start  and select Programs.

2. Select PowerPoint Mobile .

3. In the presentation list, highlight the presentation you want to play.

4. Press Center.

5. Do any of the following:

■ Press Right  to advance to the next slide or Left  to view the previous slide. 

■ Press Menu , select Go to Slide, and select the slide you want to view.

■ Select Next or Previous to play animations.

■ Press Menu , select Zoom In, and then select  to zoom in or  to zoom out. To 
scroll within the current slide, tap and drag the slide. To return to the slide show, 
select .

6. Press Menu  and select End Show.
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EXCEL MOBILE

With Excel Mobile you can create and edit workbooks and templates on your smartphone. You 
can also edit workbooks and templates that you create on your computer. However, keep in mind 
that you may lose some of the information and formatting when you save the workbook on your 
smartphone. See your User Guide for details on supported and unsupported features.

Creating a workbook

1. Press Start  and select Programs.

2. Select Excel Mobile .

3. Press New .

4. Highlight a cell where you want to enter text or other info. 

5. Enter the info in the cell, and then press Enter .

6. Repeat steps 4 and 5 to enter the remaining info.

7. Press OK  to save the file.

Entering a formula
1. Highlight the cell where you want to enter the formula.

2. Enter an = sign followed by any values, cell references, name references, operators, and 
functions. 
Example: =(B4/25)+100=Revenue-Expenses 

3. Press Enter . 
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Inserting a function
1. Open the workbook where you want to insert the function.

2. Press Menu  and select Insert > Function.

3. Select the Category list, and then select the type of function you 
want to insert.

4. Select the Function list, and then select the specific function you 
want to insert.

5. Select OK.

Creating a chart
1. Open the workbook you want to create a chart from.

2. Highlight the cells you want to include in the chart.

3. Press Menu  and select Insert > Chart.

4. Select the type of chart, and then press Next .

5. Confirm the area you want the chart to include, and then press Next .

6. Select the data layout, and then press Next .

7. Check the boxes to indicate whether the first row and column represent labels.

8. Select whether you want the chart to appear as a separate worksheet within the current 
workbook, or as part of the current worksheet. 

9. Press Finish .
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FINDING INFORMATION

With the built-in search features on your smartphone, you can find information quickly:

■ Lookup: Helps you find and dial your contacts by name or phone number. See “Dialing by 
contact name” on page 23 for details.

■ Search: Looks through the text in all the applications on your smartphone.

■ File Explorer: Lets you browse files and folders on your smartphone or an expansion card.

Using Search
Search for files and other items stored in the My Documents folder on your smartphone or on an 
expansion card. You can search by file name or by words located in the item. For example, you 
can search for words within notes, appointments, contacts, and tasks. 

1. Press Start  and select Programs.

2. Select Search .

3. Select Search for, and then enter the file name, word, or other 
info you want to find. 

4. Select the Type list, and then select the kind of information you 
want to find. 

5. Press Search , and then use the 5-way to select and view 
an item from the search results.
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Exploring files and folders
File Explorer lets you browse the contents of folders on your smartphone. The root folder on your 
smartphone is named My Device. My Device is similar to My Computer on your computer. 

1. Press Start  and select Programs.

2. Select File Explorer .

3. Select the Show list in the upper left, and then select the folder you want to explore. 

4.  Do any of the following:

■ To open an item, select it. 

■ To quickly delete, rename, copy, beam, or email an item, highlight the item, press and 
hold Center to open the shortcut menu, and then select the appropriate command. 

■ To highlight multiple items, tap and drag the stylus. 

[ ! ] IMPORTANT Do not delete any files that you cannot identify. These files may be required for your smartphone to 
function properly.
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INSTALLING APPLICATIONS

You can install any of the additional software included on the Windows Mobile Getting Started 
Disc as well as other third-party applications that are compatible with Windows Mobile 5.0 
devices. To learn more, go to www.palm.com/mytreo700wVerizon.

NOTE Be sure to select and install Microsoft Windows Mobile 5.0 software for Pocket PC Phone Edition. Microsoft 
Windows Mobile 5.0 software for Smartphone is not compatible with your Treo™ smartphone. If an application does not have 
a Microsoft Mobile to Market certificate, you will see a message indicating that the application is untrusted. If this occurs, you 
can indicate whether you want to continue the installation. 

Installing applications from the Internet
You can use Internet Explorer Mobile to install Windows Mobile apps in the CAB file format 
directly from the Internet. You must use your computer to install apps in other file formats.

1. Make sure your phone is on (see “Turning your phone on and off” on page 3).

2. Press Start  and select Internet Explorer.

3. Go to the page that contains the link to the application you want to download.

4. Press Left  or Right  to highlight the link to the file, and then press Center to start the 
download process.

5. Press Start  and select Programs.

6. Select File Explorer .

7. Go to the My Documents folder in File Explorer.

8. Tap the file you downloaded to start the installation program.
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Installing applications from your computer
1. Open My Computer or Windows Explorer on your computer. 

2. Copy the application file(s) into the  Mobile Device folder.

3. Connect your smartphone to your computer to synchronize and install the application(s) on 
your smartphone.

Installing applications onto an expansion card
1. Insert the expansion card into the expansion card slot (see “Removing and inserting 

expansion cards” on page 77).

2. Open the ActiveSync® window on your computer. 

3. Click Tools and select Explore Device.

4. Double-click My Windows Mobile-Based Device  to open the Mobile Device folder.

5. Copy the application file(s) into the Storage Card folder inside the Mobile Device folder.

SETTING SYNCHRONIZATION OPTIONS

Selecting which info to sync

1. Press Start  and select Programs.

2. Select ActiveSync . 

3. Press Menu  and select Options.



4. Do any of the following: 

■ Check the box next to any items you want to synchronize. If 
you cannot check a box, you might have to uncheck a box 
for the same information type elsewhere in the list. 

■ Uncheck the box next to any items you want to stop 
synchronizing. 

■ Select an item and then select Settings to customize the 
settings for that item. Settings are not available for all items.

Starting and stopping synchronization
If ActiveSync is running on your computer and you connect your smartphone to your computer, 
synchronization begins automatically. If you ever need to manually start or stop synchronization, 
follow these steps:

1. Connect your smartphone to your computer (see the setup poster for details). If you are only 
synchronizing wirelessly with Exchange Server, you do not have to connect the device. 

2. Press Start  and select Programs.

3. Select ActiveSync .

NOTE To end synchronization before it completes, select Stop. 
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Synchronizing with Exchange Server
You can sync with Exchange Server using a connection to a wireless network or a computer. 

1. Press Start  and select Programs.

2. Select ActiveSync .

3. Press Menu  and select Configure Server. If you have not yet set up sync with Exchange 
Server, this says Add Server Source. 

4. Select Server address, enter the name of the server running Exchange Server, and then press 
Next . 

5. Enter your name, password, and domain, and then press Next . To change the rules for 
resolving synchronization conflicts, select Advanced. 

6. Check the boxes next to the type of info that you want to synchronize with Exchange Server, 
and then press Finish . 

Setting the synchronization schedule
You can schedule wireless synchronization to occur automatically at regular intervals. If you 
prefer to synchronize manually, do not turn on these settings.

1. Connect your smartphone to your computer (see the setup poster). If you are only 
synchronizing wirelessly with Exchange Server, you do not have to connect the device. 

2. Press Start  and select Programs.

3. Select ActiveSync .

4. Press Menu  and select Schedule.
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5. Set any of the following options:

■ Peak times: Sets the frequency for high-traffic time periods such as when you are at work 
or when email volume is high.

■ Off-peak times: Sets the frequency for low-traffic time periods such as late at night. 

■ Use above settings while roaming: Sets the frequency while you are roaming outside the 
Verizon Wireless network. To minimize roaming charges, uncheck this box and 
synchronize manually while roaming.

■ Send outgoing items immediately: Sets whether items are sent as soon as you select Send 
in the Messaging application, or whether they are held until the next synchronization. 

6. Press OK .

NOTE Decreasing the frequency settings conserves battery power.

USING EXPANSION CARDS

The expansion card slot on your smartphone lets you add SD cards and MultiMediaCard cards to 
extend the storage capacity of your smartphone. For example, expansion cards can store pictures 
and videos, MP3 audio files, email attachments, games, and much more. Your smartphone is 
also compatible with most SDIO cards—which let you add accessories, such as a Wi-Fi® network 
card, to your smartphone. Expansion cards are sold separately. 

NOTE See “Regulatory Information” in the User Guide for guidance in using a Wi-Fi card with your Treo 700w smartphone.
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Removing and inserting expansion cards
Your smartphone comes with a dummy card inside 
the expansion card slot. When you do not have a 
functioning card inside the slot, reinsert the dummy 
card to protect the slot opening.

1. Press down and release the dummy card.

2. After you feel the dummy card eject from the slot, 
remove the card from the slot.

3. To insert an expansion card, hold your 
smartphone with the screen facing you and the 
card with the label facing you. The notch on the 
card should be in the lower corner by the antenna.

4. Insert the card into the expansion card slot until 
you feel it lock into place and hear the 
confirmation tone. 

Notch
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TODAY SCREEN SETTINGS

Selecting your Today screen background

1. Press Start  and select Settings.

2. On the Personal tab, select Today .

3. On the Appearance tab, check the Use this picture as the 
background box.

4. Select Browse.

5. Select the picture you want for your Today screen background.

6. Select the Items tab.

7. Check the boxes next to the items you want to appear on your 
Today screen and uncheck any items that you want to hide.

8. (Optional) Select Options (if available) to configure the settings 
for the current item. Press OK  to return to Today Settings.

9. Press OK .
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SOUND SETTINGS

Setting ringtones
You can set different tones for different types of incoming phone calls and notifications.

1. Press Start  and select Settings.

2. On the Personal tab, select Sounds & Notifications .

3. Select the Notifications tab.

4. Select the Event list, and then select which type of call or notification you want to set the 
ringtone for:

■ Phone: Known Caller: An incoming call from someone in your 
Contacts list or Speed Dial list.

■ Phone: Missed call: A call you did not answer.

■ Phone: Roaming: A call that comes in when you’re outside 
your home mobile network.

■ Phone: Unknown Caller: An incoming call from someone 
identified by caller ID who is not in your Contacts list or Speed 
Dial list. 

■ Phone: Voice mail: A new voicemail.

5. Select the Ring type list, and then select the ring style for the selected type of call.

6. Select the Ring tone list, and then select the sound for the selected type of call.
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7. Check the Vibrate when… boxes to turn the vibrate feature on/off based on the ringer switch 
setting.

8. (Optional) Select Play to preview the sound.

9. Repeat steps 4–7 to select ringtones for other types of calls. 

10. Press OK .

Setting the ringer switch
In certain situations, such as meetings and theaters, you need to turn off all sounds on your 
smartphone. You can silence all sounds on your smartphone, including smartphone ringtones, 
Calendar notifications, and system sounds. This does not mute the speaker during phone calls.

1. Slide the ringer switch to Sound Mode Off .

2. To hear all sounds again, slide the ringer switch 
to Sound Mode On .

When you slide the ringer switch back to the Sound 
Mode On position, it restores the previous sound 
settings. For example, if the smartphone ring volume 
is set to the loudest setting and you slide the ringer 
switch to Sound Mode Off, you do not hear the 
smartphone ring. When you move the ringer switch 
back to Sound Mode On, the smartphone ring volume 
is still set to the loudest setting.

Sound
Mode On

Sound 
Mode Off
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C U S T O M I Z I N G  Y O U R  S M A R T P H O N E
Selecting Sounds & Notifications

1. Press Start  and select Settings.

2. On the Personal tab, select Sounds & Notifications .

3. On the Sounds tab, set any of the following options:

■ Events: Turns sounds on/off for system warnings and error 
messages.

■ Programs: Turns sounds on/off in the applications on your 
smartphone. 

■ Notifications: Turns alarms and reminders on/off in the 
applications on your smartphone.

■ Screen taps: Turns sounds associated with tapping the screen on/off, and sets the volume 
level when this sound is turned on.

■ Hardware buttons: Turns sounds associated with pressing buttons on/off, and sets the 
volume level when this sound is turned on.

4. Select the Notifications tab and set any of the following options:

■ Event: Specifies which action you want to change the settings 
for. The remaining options vary based on the action selection.

■ Play sound: Lets you turn the sound on/off for the selected 
event. To select a different sound select the list to the right of 
this setting, and then select a different sound. To preview the 
sound, select Play Sound, and then select Play.
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■ Repeat: Indicates whether the sound plays more than once, if turned on.

■ Display message on screen: Indicates whether a notification message appears onscreen 
for the selected event.

■ Vibrate: Indicates whether your smartphone vibrates to notify you about the selected 
event.

5. Press OK .

DISPLAY AND APPEARANCE SETTINGS

Adjusting the brightness

1. Press Option , and then press . 

2. Press Left  and Right  to adjust the brightness.

3. Press OK .

Changing the text size

1. Press Start  and select Settings.

2. Select the System tab, and then select Screen .

3. Select the Text Size tab. 

4. Press Left  and Right  to adjust the text size.

5. Press OK .
82



C U S T O M I Z I N G  Y O U R  S M A R T P H O N E
APPLICATION SETTINGS

Arranging the Start menu

1. Press Start  and select Settings.

2. On the Personal tab, select Menus .

3. Check the boxes next to the applications you want to see in the 
Start menu. 

4. Press OK .

Reassigning buttons
Buttons Settings lets you select which applications are associated 
with many of the buttons and key combinations on your smartphone.

1. Press Start  and select Settings.

2. On the Personal tab, select Buttons .

3. On the Program Buttons tab, highlight the button or key 
combination you want to change in the Buttons list. 

4. Select the Assign a program list, and then select the application 
you want to assign to the button or key combination you selected 
in step 3.

5. Press OK .
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LOCKING YOUR SMARTPHONE AND INFO

Your smartphone includes several features that help you protect your smartphone from 
inadvertent use and keep your information private. The built-in security software lets you use 
your smartphone for emergency calls, such as dialing 911, even if it is locked.

■ Keyguard: Manually disables all buttons and the screen’s touch-sensitive feature to prevent 
accidental presses in your briefcase or pocket.

■ Auto-Keyguard and touchscreen lockout: Automatically enables Keyguard after a period of 
inactivity and lets you disable the screen’s touch-sensitive feature during an active call.

■ Phone Lock: Requires a lock code to make calls. See the User Guide for details.

■ System password lock: Requires a password to see any information on your smartphone.

Using Keyguard
By default, your keyboard locks so that you don’t accidentally press buttons or activate screen 
items while your smartphone is in a pocket or bag.

■ To turn off Keyguard, press Center.

■ To manually turn on Keyguard when your smartphone screen is on, press Option  and 
Power/End .
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C U S T O M I Z I N G  Y O U R  S M A R T P H O N E
Using Auto-Keyguard and touchscreen lockout
Auto-Keyguard lets you automatically lock the keyboard after a period of inactivity.

1. Press Start  and select Settings.

2. On the Personal tab, select Keyguard .

3. Set any of the following options:

■ Auto-Keyguard: Sets the period of inactivity that passes before 
the keyboard automatically locks, or disables the auto-
keyguard feature.

■ Disable touchscreen: Indicates whether the screen’s touch-
sensitive feature is enabled during a call. 

4. Press OK .

NOTE If you’re using a headset or hands-free device and your smartphone is in a pocket or bag, you can manually turn on 
Keyguard during a call to prevent accidental key presses. Press Option and Power/End to manually turn on Keyguard.
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SYSTEM SETTINGS

Turning Wireless Services On/Off 

1. Press Start  and select Settings.

2. Select the System tab, and then select Power .

3. Select the Wireless tab and turn your smartphone’s wireless features on/off.

4. Select the wireless signals you want to control when you turn Flight Mode on and off.

5. Press OK  to finish.

NOTE You can also turn Flight Mode on and off by tapping the signal-strength icon  at the top of the screen. 
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G E T T I N G  H E L P
G E T T I N G  H E L P

PERFORMING A SOFT RESET

A soft reset is similar to restarting a computer. If your smartphone is not responding or you have 
trouble synchronizing with your computer, a soft reset may help.

1. Use one hand to press the battery door release and use the other hand to slide the battery 
door downward to remove it from your smartphone.

2. Use the stylus tip to gently press the reset button on the back of your smartphone.

3. Wait for the progress bar on the Treo™ smartphone logo screen to fill before continuing to 
use your smartphone.

NOTE If the phone and Bluetooth signals were on before a reset, these signals automatically turn on after the reset.
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WHERE TO LEARN MORE

For a quick introduction
■ Quick Tour: The Quick Tour highlights many of your smartphone’s features. It is already 

installed on your smartphone, and you can open it at any time. Press Start , select 
Programs, and then select Quick Tour . 

■ Interactive User Guide: An interactive introduction to your smartphone. To access the 
Interactive User Guide, insert the Welcome CD into your computer’s CD drive.

While using your smartphone
■ Help: Many of the built-in applications include on-device Help, so that you can learn about the 

tasks you can perform in that application. To access Help, go to the application or screen you 
want help with, press Start , and select Help. 

■ User Guide: A complete guide to your smartphone’s features with detailed step-by-step 
instructions, tips, and troubleshooting info. To access the User Guide on your desktop 
computer, click Start > All Programs > Palm > Treo 700w User Guide, or go to:
www.palm.com/Treo700wVerizon-UserGuide.

■ Online support from Palm: For up-to-date downloads, troubleshooting, and support 
information, check out www.palm.com/us/support/us/support/Treo700wVerizon.
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G E T T I N G  H E L P
If you need more information
■ Books: Many books on Windows Mobile devices are available in local or online book retailers 

(look in the computers section), or visit www.palm.com/mytreo700wVerizon.

■ Online forums: Consult online Treo™ smartphone user discussion groups to swap 
information and learn about topics you may find nowhere else. Visit
www.palm.com/us/support/us/support/Treo700wVerizon for details.

■ Verizon Wireless Customer Care: For questions about your mobile account or features 
available on the network, contact Verizon Wireless Customer Care or visit 
www.verizonwireless.com for the latest information and help.
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R E G U L A T O R Y  I N F O R M A T I O N
R E G U L A T O R Y  I N F O R M A T I O N
FCC Statement This equipment has been tested and found 
to comply with the limits for a Class B computer peripheral, 
pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or 
television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: 

■ Reorient or relocate the receiving antenna. 

■ Increase the separation between the equipment and 
receiver. 

■ Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connected. 

■ Consult the dealer or an experienced radio/TV 
technician for help. 

This device complies with part 15 of the FCC Rules. 
Operation is subject to the following two conditions: (1) 
This device may not cause harmful interference, and (2) 
this device must accept any interference received, 
including interference that may cause undesired operation.

RF Safety Exposure To Radio Frequency Energy (SAR) 
Radio transmitting devices radiate Radio Frequency (RF) 
energy during its operation. RF energy can be absorbed 
into the human body and potentially can cause adverse 

health effects if excessive levels are absorbed. The unit of 
measurement for human exposure to RF energy is 
“Specific Absorption Rate” (SAR). 

The Federal Communications Commission (FCC), Industrie 
Canada (IC), and other agencies around the world have 
established limits that incorporate a substantial safety 
margin designed to assure the safety of all persons using 
this equipment. 

In order to certify this unit for sale in the US, Canada and 
Europe this unit has been tested for RF exposure 
compliance at a qualified test laboratory and found to 
comply with the regulations regarding exposure to RF 
Energy. 

SAR was measured with the unit transmitting at its 
maximum certified RF power. Often, however, during 
normal operation the unit will transmit much less than 
maximum power. Transmit power is controlled 
automatically and, in general is reduced as you get closer 
to a cellular base station. This reduction in transmit power 
will result in a lower RF energy exposure and resulting SAR 
value. 

FCC RF Safety Statement In order to comply with FCC RF 
exposure safety guidelines, users MUST use one of the 
following types of bodyworn accessories. 

1. A Palm® brand body-worn accessory that has been 
tested for SAR compliance and is intended for use 
with this product. 

2. An accessory that contains NO metal (snaps, clips, 
etc.) and provides AT LEAST 1.5 cm of separation 
between the users body and the unit. 
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Do NOT use the device in a manner such that it is in direct 
contact with the body (e.g., on the lap or in a breast 
pocket). Such use will likely exceed FCC RF safety 
exposure limits See www.fcc.gov/oet/rfsafety/ for more 
information on RF exposure safety. 

The Palm® Treo™ 700w smartphone may be used with a 
Wi-Fi® SDIO card; however, the user must ensure that the 
SDIO Wi-Fi card has been approved by the FCC for use with 
the Treo 700w smartphone. For a list of SDIO Wi-Fi cards 
approved by the FCC for use with the Treo 700w 
smartphone, please go to www.palm.com/us/support/
Treo700wVerizon.

If using a SDIO Wi-Fi card not approved for use with the 
Treo 700w smartphone by the FCC, the user must turn off 
the phone (CDMA radio) on the Treo 700w smartphone. 

Use of an SDIO wireless transmitter that is not approved in 
conjunction with the phone (CDMA radio) is not authorized 
by the FCC and may exceed FCC RF exposure guidelines.

Responsible party:
(North America) (Europe)
Palm, Inc. Bornibus Francois
950 W. Maude Ave. Buckhurst Court 
Sunnyvale, CA 94085 London Road
USA Wokingham, Berkshire 
www.palm.com/us/support RG40 1PA, UK

Antenna Care/Unauthorized Modifications Use only the 
supplied integral antenna. Unauthorized antenna 
modifications or attachments could damage the unit and 
may violate FCC regulations. Any changes or modifications 
not expressly approved by the party responsible for 
compliance could void the user’s authority to operate the 
equipment.

Potentially Unsafe Areas Potentially explosive 
atmospheres: Turn off your smartphone when you are in 
any areas with a potentially explosive atmosphere, such as 
fueling areas (gas or petrol stations) or storage facilities 
for fuel or chemicals.

Declaration of Conformity 
Treo 700w Model 

Palm declares that the above model of Treo smartphone is 
compliant with the regulations below. The declaration 
applies to the smartphone and its associated accessories 
(power supply, headset, and USB cable) where applicable.

For SAR values when used with a SDIO Wi-Fi card go to: 
www.palm.com/us/support/Treo700wVerizon.

FCC OET Bulletin 
65 Supplement C
Safety: EN 60950: 
2000 (Jan-2000)
Radiated 
Emissions: EN 
55022
FCC ID: O8FJIMI
IC ID: 3905A-JIMI 

Maximum Scaled SAR Values (W/kg)

Band  Cellular  PCS

Head SAR
(Held to ear)

(W/Kg)
1.26

(W/Kg)
1.26

Body SAR
(Worn)

(W/Kg)
1.01

(W/Kg)
.548
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R E G U L A T O R Y  I N F O R M A T I O N
Using TTY 
A TTY (also known as TDD or text telephone) is a 
telecommunications device that allows people who are deaf 
or hard of hearing, or who have speech or language 
disabilities, to communicate by telephone.

Your Treo 700w smartphone is compatible with select TTY 
devices. You can connect a TTY/TDD machine to your 
smartphone through the headset jack, but you cannot use 
your headset jack with a headset or hands-free kit while 
this mode is enabled. Please check with the manufacturer 
of your TTY device for connectivity information and to 
ensure that the TTY device supports digital wireless 
transmission.

To use TTY, you may need to make additional 
arrangements with Verizon Wireless. Please contact 
Verizon Wireless’s customer service department for more 
information.

1. Press the Start button and select Settings.

2. Select Personal, and then select Phone.

3. Select Phone.

4. Select the TTY/TDD list, and then select either Default 
mode, VCO mode, or HCO mode.

5. Press OK. A keyboard icon appears at the top of your 
Today screen whenever TTY is enabled.

To disable TTY, repeat steps 1 and 2.

Hearing Aid Compatibility Compliance Hearing aid 
compatibility ratings now appear on some handset 
packages. If your handset has a hearing aid compatibility 
rating of M3 or M4, then that handset has met or 
surpassed the American National Standards Institute’s 
(“ANSI”) hearing aid compatibility standard as adopted by 
the Federal Communications Commission.

The handset’s M-rating along with a hearing aid’s M-rating 
will assist customers in finding a handset that will work 
best for them.
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Copyright
© 2005 Palm, Inc. All rights reserved. Palm, Treo, and the 
Palm and Treo logos are among the trademarks or 
registered trademarks owned by or licensed to Palm, Inc. A 
portion of this software includes software modules 
developed by the Independent JPEG group. MPEG Layer-3 
audio decoding technology is licensed from Fraunhofer IIS 
and Thomson. Palm, Inc. is an authorized licensee of the 
MultiMediaCard trademark. All other brand and product 
names are or may be trademarks of, and are used to 
identify products or services of, their respective owners.

Disclaimer and limitation of liability
Palm, Inc. and its suppliers assume no responsibility for 
any damage or loss resulting from the use of this guide. 
Palm, Inc. and its suppliers assume no responsibility for 
any loss or claims by third parties that may arise through 
the use of this software. Palm, Inc. and its suppliers 
assume no responsibility for any damage or loss caused by 
deletion of data as a result of malfunction, dead battery, or 
repairs. Be sure to make backup copies of all important 
data on other media to protect against data loss.

P/N:406-10492-00
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